
ACCORDION PANEL MAGIC 2 

The finest and most accessible Accordion Widget anywhere 

User Guide Version | 02-May-10 

 

Accordion Panel Magic 2 installs into Dreamweaver, giving you a fully automated graphical 

user interface with which to build Accordion widgets. You can add multiple widgets to a page 

and each one can contain as many content panels as you need. Panel headings can be set to 

trigger (expand and collapse) associated content panels or you can set one or more headings 

to be ordinary links to other pages. 

We hope you enjoy using this product as much as we did making it. 

Al Sparber & Gerry Jacobsen PVII 
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INSTALLATION 

The installation procedure depends on whether you purchased the full version or the 

upgrade version. 

INSTALLING THE FULL VERSION 

Look for the extension installer file p7_APM2_220.mxp (or higher) in the root of the zip 

archive you downloaded. Double-click the file to install the extension. Dreamweaver's 

Extension Manager will open and you will be prompted to complete the installation. Restart 

Dreamweaver once the installation is complete. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have a file association 
issue. To remedy the problem locate the installer file from inside a Finder window and double-click it. 

INSTALLING THE UPGRADE VERSION 

Using the upgrade version requires that Accordion Panel Magic 1 is installed. Once 

you install the upgrade you will be able to use both versions. 

Look for the extension installer file p7_APM2_220_UPG.mxp (or higher) in the root of the zip 

archive you downloaded. Double-click the file to install the extension. Dreamweaver's 

Extension Manager will open and you will be prompted to complete the installation. Restart 

Dreamweaver once the installation is complete. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have a file association 
issue. To remedy the problem locate the installer file from inside a Finder window and double-click it. 
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BEFORE YOU BEGIN 

WORK IN A DEFINED DREAMWEAVER WEB SITE 

Before you begin, make sure you are working inside a defined Dreamweaver web site. This is 

necessary so that Dreamweaver knows how to link required assets. If you are new to 

Dreamweaver or need to learn how to define a web site, please see this tutorial: Defining a 

Dreamweaver Web Site. 

ASSET FOLDERS 

When you create an Accordion Panel Magic 2 widget, the system creates an assets folder 

named p7apm at the same level as the page that contains your widget. This folder will 

contain the Accordion Panel Magic 2 JavaScript file and the relevant style sheet(s), as well as 

an img sub-folder that contains the background images for each style theme you are using. 

When you publish your site, make sure you upload the entire p7apm folder. 

A Fireworks folder will also be created at the same level as the p7apm folder and will contain 

editable versions of all necessary background images. The Fireworks folder does not 

need to be uploaded to your Web server. 

  

http://www.projectseven.com/products/menusystems/pmm/user_guide/getting_started/before_define.htm
http://www.projectseven.com/products/menusystems/pmm/user_guide/getting_started/before_define.htm
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USING ACCORDION PANEL MAGIC 2 

The user interface allows you to quickly create, configure, or modify Accordion Panel Magic 2 

widgets. Let's explore how it works. 

INSERTING A NEW ACCORDION PANEL  

Establish the insertion point for your new Accordion Panel widget by clicking in the area of 

the page where you would like the widget to be created.  

Note: The interface is sensitive to the insertion point. If your cursor is currently inside an existing Accordion Panel widget then 

the Modify interface will open instead.  

Click the Accordion Panel Magic 2 icon  in the Common Section of Dreamweaver's 

Insert Bar or choose: 

Insert > Studio VII > Accordion Panel Magic 2 by PVII. 

CLASSIC DREAMWEAVER INSERT BAR 

 

DREAMWEAVER CS4 INSERT PANEL 

 

Dreamweaver CS4 Users: We highly recommend switching to Classic Workspace mode, which allows for a conventional Insert 
Bar across the top of your Design View window. If you use the new CS4 workspaces, the Insert Bar becomes a vertical panel 
that violates basic Windows and OS X interface conventions making it somewhat hard to use as it lacks support for mouse 
wheel and keyboard scrolling. We are hoping Adobe will fix this (and other) UI issues in the next version of Dreamweaver. 
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The Accordion Panel Magic 2 user interface will open in the Create New Accordion Panel 

mode.  

 

You can create more than one Accordion Panel widget on your page. 

Note: When you insert an Accordion Panel, all content will be visible and fully expanded in Dreamweaver to make adding and 
editing content a simple task. The Accordion Panel functionality can be tested by previewing in your browser. 
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ASSET FOLDERS 

When you create an Accordion Panel Magic 2 widget, the system creates an assets folder 

named p7apm at the same level as the page that contains your widget. This folder will 

contain a JavaScript file, relevant CSS file (or files), as well as an img sub-folder that contains 

the background images used by the CSS. 

 

When you publish your site, make sure you upload the entire p7apm folder. 

Note: A Fireworks folder will be created at the same level as the p7apm folder and will contain editable versions of all 

necessary background images. The Fireworks folder does not need to be uploaded to your Web server .  
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MODIFYING AN EXISTING ACCORDION PANEL 

You can modify any of the existing Accordion Panel widgets on your page at any time. 

-Click inside the Accordion Panel widget that you wish to modify. 

-Click the Accordion Panel Magic 2 icon  in the Common Section of Dreamweaver's 

Insert Bar or choose Modify > Studio VII > Modify Accordion Panel Magic 2 by PVII 

Note: If you use a Macintosh computer, Apple bugs will sometimes cause the Modify menu to be inactive (grayed out). If this 
happens to you, use the icon to lauch the interface. You can also launch the interface from the Insert menu. The system will 
detect your insertion point and if it is inside an existing widget, the Modify interface will open. 

The Accordion Panel Magic 2 User Interface will open in the Modify Existing Accordion Panel 

mode. 
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EXPLORING THE USER INTERFACE 

MODE 

Displays the current operational Mode for the user interface: either Create or Modify. When in 

Modify mode, the id of the Accordion Panel widget being modified will also be displayed. 

PANEL HEADINGS  

This box displays the text for each heading link in the Accordion Panel—one line for each 

panel or external link. Select (click) the line you'd like to act on. 

ADD 

Click the Add button to add a new panel heading and an associated content panel. A new line 

will be created with the default text "Heading Text". The new line will be created immediately 

after the currently selected line. 

DELETE 

Click the Delete button to remove the currently selected line. The heading and its associated 

content panel will be removed.  

UP  

The Up button will move the selected Panel Heading up one row. Successive clicks will keep 

moving it up, one row per click, until it's at the top of the list.  

DOWN 

The Down button will move the selected Panel Heading down one row. Successive clicks will 

keep moving it down, one row per click, until it's at the bottom of the list. 
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HEADING TEXT 

The Heading Text box will always display the text of the currently selected Panel Heading. 

Enter or edit the text that you wish to display for this panel heading. The box cannot be 

left blank. 

Note: If an image has been assigned, this box will be disabled (grayed out) and contain the file name of the assigned image. 
Removing the Image Path will re-enable this box. 

LINK ONLY -NO ASSOCIATED CONTENT PANEL  

Check this box if you wish to have the selected Heading Text serve as a normal page link. If 

you do so, there will be no content panel associated with it. If you are setting an existing 

Panel Heading to Link Only its formerly associated content panel will be removed. 

LINK PATH / BROWSE...  

The Link box is activated whenever the Link Only box is checked. Enter the path to the 

linked page for this panel heading or use the Browse button to open the Select File to Link 

dialog box. If no entry is made, the system will automatically supply a "javascript:;" null link. 

TRIGGER IMAGE / BROWSE... 

Note: The Image Path box is only used if you are using images for your headings. For text-based headings this box should be 

left empty.  

Enter the path to your heading image, or use the Browse button to open the Select Image 

Source dialog box. You can change the image at any time by selecting the heading item in 

the Panel Heading list and clicking the Browse button. Valid image types are: .gif, .jpg, and 

.png. 
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The image you select must always be the default state image. The system will handle image 

preloading for over, down, and overdown images based on the Image Swap Option you 

select. Your default state image file names can be anything you like. However, you must 

follow a naming convention for the swap images.  

If you name your default image myButton.gif... 

 The mouse over image would be: 

myButton_over.gif  

 The image that appears when its associated content panel is open would be: 

myButton_down.gif 

 The image that appears when a link in the heading's associated content panel matches 

the current page address would be: 

myButton_overdown.gif. 

 

ALT TEXT 

Enter a description (Alt Text) for the related image. If the text on the image is "Products" then 

Products would be a good choice for the Alt text. 

OPTIONS 

These settings are applied to the current Accordion Panel widget. Other Accordion Panel 

components on the same page can have different Options.  

TRIGGER ACTION 

SHOW ONE PANEL AT A TIME 

Select this option to automatically close any other open panels when a new panel is opened. 

This ensures that only one panel is displayed at a time. This option toggles open panels only 

within the same Accordion Panel widget. Other widgets on the page will not be affected. 
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ALWAYS KEEP ONE PANEL OPEN 

This setting will ensure that your Accordion Panel will never be completely closed. Successive 

clicks on the currently open panel heading text will not close that panel. 

ENABLE MOUSE OVER OPEN ACTION 

Check this box to allow mouse over activation of the panel headings. The associated panel 

will open whenever the user moves his mouse over the panel heading. The click behavior to 

open or close the panel will still remain enabled. 

ENABLE MOUSE OUT CLOSE ACTION 

Check this box if you wish to allow a close action when the user mouses off the Heading Text 

onto another area of the page. Mouse Out close action will also take place when the user 

moves his mouse out of the content panel. 

PAGE LOAD 

You can choose the Accordion Panel startup configuration when the page first loads into the 

browser. Select one of the following: 

 Open With All Panels Closed -The Accordion Panel will start out with all panels closed. 

 Open a Specific Panel - You can select a specific panel to open when the Accordion 

Panel initializes. Selecting this option will activate the Panel Number box where you 

can enter the number of the panel you wish to be open on startup. 

 Open a Random Panel - Select this option if you wish to have the system randomly 

select a panel to open. Each time the page loads into the browser a random panel will 

be selected. 

 Open All Panels - Select this option if you want all panels open when your widget 

loads. 

 Open All Panels Then Close All - This option will start the Accordion with all of its 

panels open—and will then glide them all closed. 
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PANEL NUMBER 

This box is only enabled when you choose the "Open A Specific Panel" Page Load option. 

Enter the panel number that you want open when the page first loads. 

USE CURRENT MARKING 

Check this box to enable automatic current marking (highlighting) of links in your Accordion. 

The system looks for links in the Accordion that match the current page URL (address). When 

a match is found, the link is highlighted and the panel that contains the link automatically 

opens. The system assigns a special style class named current_ mark to this link and also to 

its parent panel heading. This provides a visual you are here indicator. 

AUTO ROTATE PANELS ON STARTUP 

This feature is designed to open each panel in succession when the page first loads—letting 

visitors see all of the content panels. You can set the timing between panel transitions and 

you can also set the number of cycles to loop. The Accordion Panel Magic 2 system also 

includes a fully-featured Rotate Behavior that can be used to provide additional control 

interactively. 

Check this box to enable the auto rotate feature on page startup. 

Cycles -The system will display all of the panels in succession once—or you can set it to loop 

any number of times. Enter the number of times you want the system to loop through the 

rotation. 

Delay -This controls the amount of time each panel is displayed during the rotation, in 

milliseconds. The default is 1000ms (1 second). To display each panel for 5 seconds, for 

example, enter 5000 into the Delay box. 

  



 

©2010 Project Seven Development Page 17 

 

17 Using Accordion Panel Magic 2 

IMAGE SWAP OPTIONS 

The system supports using images for any of the Heading links and is designed to 

automatically handle preloading, swapping, maintaining states, and assigning a current 

marker. This automation requires that you follow the image file name convention. The 

system supports up to 4 different image states. Select the Swap Option that you would like to 

use:  

 Single Image Only -Choose this option if you are using just a single image and do not 

want any image swap actions on any of the heading states.  

 Normal and Over - Choose this option if you are using two images: one normal image 

and one for the over (hover) state. The over state image will also be used as the open 

(down) state and current mark images. 

 Normal, Over and Open Images - Choose this option if you are using three images: one 

normal image, one for the over (hover) state, and one for the open (down) state. The 

open state image will be used for the current marker images.  

 Normal, Over, Open and Mark - Choose this option if you are using four images: one 

normal image, one for the over (hover) state, one for the open (down) state, and one 

for the current marker state. 
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NAMING CONVENTION 

If you name your default image myButton.gif... 

 The mouse over image must be named: 

myButton_over.gif  

 The image that appears when its associated content panel is open must be named: 

myButton_down.gif 

 The image that appears when a link in the heading's associated content panel matches 

the current page address must be named: 

myButton_overdown.gif. 

Note: Be sure to choose the option carefully to match the number of image states you are using. The system will pre-load the 

various state images based on this selection. 

ROLLOVER OPEN STATE 

This controls the swap action when the menu item is in its open state. The system will swap 

to the over image if the menu item is in the open state. Uncheck the box if you want to 

disable this swap action. 

ROLLOVER MARK STATE 

This controls the swap action taken when the menu item is in its current marked state. The 

system will swap to the over image on rollover if the menu item is in the current marked 

state. Uncheck this box if you want to disable this feature. 
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ANIMATION METHOD 

You can select one of three different animation options: 

 0-None -Choose this option to disable animation. 

 1-Glide-Normal - This setting will glide the panels open or closed based on a time 

duration. The more content you have in a panel, the faster the animation will appear 

to be. You can adjust the Duration setting to increase or decrease the animation's 

speed. 

 2-Glide-Gradual Stop -This setting will smoothly glide the panels open or closed. 

Glide speed automatically adjusts to the height of the content panel and the 

animation will come to a gradual stop. 

DURATION 

This option is only enabled when the Glide-Normal animation method is used and allows you 

to control the speed of the gliding effect. Duration defines the total amount of time that the 

animation will run, in milliseconds, regardless of a content panel's height. The default 250 (a 

quarter of a second) is fine in most cases. Lower the Duration setting and the animation will 

be faster. Raise the setting to make the animation slower. 

STYLE THEME 

Accordion Panel Magic 2 comes with a variety of pre-defined CSS style themes. Choose a 

theme that best approximates the look you want. This will act as a starting point from which 

you can later make edits to the style sheet to fully customize your Accordion Panel(s). You 

can change to a different style type at any time without affecting the contents of the 

Accordion Panel widget.  

A preview of the selected Style Theme is displayed to the right of the Style Theme select list. 

This Preview will change whenever you select a different Style Theme. 
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THE INTERFACE CONTROL BUTTONS 

OK 

When you are done, click the OK button to build the Accordion Panel. The system will verify 

your selections and alert you to any problems that need your attention. If there are no 

problems, the interface will close and an Accordion Panel will be added to your page or 

updated—depending on whether you are in Create mode or Modify mode. You can then 

preview in a browser to operate the Accordion Panel and check its functionality. 

Tip: To make further changes, click inside an Accordion Panel to open the interface. 

CANCEL 

Click the Cancel button to completely abort the current operation. This will close the 

interface and no changes will be made to your page. 

USER GUIDE 

Click the User Guide button to launch the Accordion Panel Magic 2 user guide home page. 

The user guide is hosted on our servers so you must be connected to the internet. The user 

guide home page contains instructions on how to view the document in your browser or how 

to download it for local viewing and printing. The user guide home page will also note 

whether an updated version of the guide is available and will contain links to supporting 

documentation or tutorials as they become available. 

HELP 

Click the Help button to open the associated Help File in your browser. This page can remain 

open for easy reference while you continue working with the Accordion Panel Magic 2 

interface. 
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PVII ACCORDION PANEL MAGIC 2 -REMOVE 

OVERVIEW 

The Accordion Panel Magic 2 system includes a Remove feature that allows you to thoroughly 

remove an existing Accordion Panel Magic 2 widget from your page. This feature allows for 

easy removal when simply prototyping pages or when a total redesign is necessary. 

OPEN THE REMOVE PVII ACCORDION PANEL MAGIC 2 INTERFACE 

-Open a page that contains one or more Accordion Panel Magic 2 widgets. 

-Choose Commands > Studio VII > Remove Accordion Panel Magic 2... to open the Remove 

interface.  

 

The Remove option will be unavailable (grayed out) in the menu if there is no Accordion Panel Magic 2 widget on the page.  

The Remove Accordion Panel Magic 2 interface will open. 

 

The interface will provide a listing of all of the Accordion Panel widgets on your page by 

displaying the ID of each widget.  
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-Select the Accordion Panel widget that you wish to remove from the listing. You can only 

remove one Accordion Panel widget at a time. 

Tip: If you are unsure which Accordion Panel widget relates to which ID, click the Cancel button and switch to Code View. In 
Code View, locate all IDs that begin with p7APM. The opening DIV tag for an Accordion Panel widget looks like this: <div 
id="p7APM_1" class="p7APM01""> 

WHAT WILL BE REMOVED  

The system will completely remove the html markup for the selected Accordion Panel widget. 

If there are other Accordion Panel widgets on the page they will not be affected. The system 

will also remove the link to the Accordion Panel CSS file if no other Accordion Panel 

widget on the page is using the same style theme. 

If there are no remaining Accordion Panel widgets on your page, the system will also remove 

the link to the Accordion Panel JavaScript file. 

WHAT WILL NOT BE REMOVED 

The system will not remove the p7apm folder, which contains the Accordion Panel-related 

assets (images, JavaScript file, and CSS files). This ensures that you will not lose any assets 

you may have modified and any other pages that depend on those modified assets will 

continue to look and behave as expected. 

THE INTERFACE CONTROL BUTTONS 

REMOVE 

Click the Remove button. The selected Accordion Panel Magic 2 widget will be removed from 

the page 

CANCEL 

Click the Cancel button to completely abort the current Remove Accordion Panel Magic 2 

operation. This will close the interface and no changes will be made to your page. 

HELP 

Click the Help button to open the associated Help File in your browser. This page can remain 

open for easy reference while you continue working with the Accordion Panel Magic 2 

interface. 
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PVII ACCORDION PANEL MAGIC 2 

IMAGE FILE NAMING CONVENTION 

OVERVIEW 

The Accordion Panel magic 2 system fully supports using images for heading links. The 

system is designed to automatically handle preloading, swapping, multiple state 

management and current marking.  

The system supports up to 4 different image states: 

 Normal - the base image 

 Over - appears on mouseover 

 Open - appears when the menu item's related sub menu is open 

 Mark - appears when the menu item has been current marked 

The system handles the state of each image automatically based on the Image Swap option 

you choose in the User Interface.  

You do not need to use all four states. You can choose to use a single image or two-

state, three-state or four-state image swaps. This automation requires that you follow the 

image file name convention. The file names of your button images can be anything you like. 

You must, however, follow a naming convention for the "over", "open" and "mark" images. 

For example, if you name your default image myButton.gif... 

 The image you want to appear when users mouse over it would be: myButton_over.gif  

 The image you would want to designate the open state would be named: 

myButton_down.gif 

 The image you want to designate as the current marked state would be: 

myButton_overdown.gif. 

Note: While the Swap Options can be set differently for each Accordion Panel Magic 2 widget on the page, the naming 

convention is global and will be used for all of the widgets on your page. 

  



 

©2010 Project Seven Development Page 24 

 

24 
PVII Accordion Panel Magic 2 

Image File Naming Convention 

ACCORDION PANEL MAGIC 2 DEFAULT NAMING CONVENTION: 

 Normal Image: myButton.gif 

 Over Image: myButton_over.gif 

 Open Image: myButton_down.gif 

 Mark Image: myButton_overdown.gif 

The default naming convention is designed to work with the default Fireworks naming 

convention for the over, open and mark an image—which, unfortunately, seems to change 

from version-to-version. So we made the convention configurable to allow synching with 

your image editor's capabilities or your own requirements. The basic image name must be 

the same for all four button images, but the appendage you use to differentiate the rollover, 

open and mark images can be anything you like. 

CHANGING THE IMAGE NAMING CONVENTION 

1. Open the p7APMscripts.js file located in the p7apm folder. Near the top of the file you will 

see 3 lines (not counting the comments): 

// define the image swap file naming convention 

// rollover image for any image in the normal state 

var p7APMover='_over'; 

// image for any trigger that has an open sub menu -no rollover 

var p7APMopen='_down'; 

// image to be used for current marker -no roll over 

var p7APMmark='_overdown'; 

2. To change the naming convention simply change the assigned text that follows the equal 

(=) sign in each of the three lines.  
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Image File Naming Convention 

For example, if you want to change the naming convention to use the appendages _over, 

_open, and _marked, change the assignments so they look like this: 

// define the image swap file naming convention 

// rollover image for any image in the normal state 

var p7APMover='_over'; 

// image for any trigger that has an open sub menu -no rollover 

var p7APMopen='_open'; 

// image to be used for current marker -no roll over 

var p7APMmark='_marked'; 

3. Save and close the file. 

Now the Accordion Panel Magic 2 system will use this revised naming convention to locate 

the over, open and mark state images. The image file names, using this customized naming 

convention, would look like: 

 Normal Image: myButton.gif 

 Over Image: myButton_over.gif 

 Open Image: myButton_open.gif 

 Mark Image: myButton_marked.gif 

As you can see, any naming convention will work by managing the text assignment for each 

image state in the scripts file. 

Note: If you create a widget in another folder or site, and you want to use a revised naming convention, you will need to update 
the scripts file in that folder. 
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BEHAVIORS 

PVII ACCORDION PANEL 2 MAGIC -TRIGGER PANEL 

OVERVIEW 

The Trigger Behavior allows you to set a link anywhere on your page to remotely operate a 

Heading Link in any Accordion Panel 2 widget on your page. The behavior can be used to 

Open, Close or Trigger (emulate a mouse click on the heading) a panel. 

CREATING A NEW TRIGGER PANEL BEHAVIOR 

1. Select (click) a text link or image to act as the behavior trigger.  

2. Open your Behaviors panel (Shift + F4)  

3. Click the plus sign (+) on the Behaviors panel.  

4. Choose Studio VII > Accordion Panel Magic 2 > Trigger Panel to open the interface.  

5. Select the panel that you wish to act on.  

6. Select the action (Open, Close or Trigger).  

7. Click OK to apply the behavior.  

 

MODIFYING AN EXISTING TRIGGER PANEL BEHAVIOR 

1. Select the element that contains an existing Accordion Panel 2 Trigger behavior.  

2. Double-click the Accordion Panel 2 Magic- Trigger Panel behavior in the Behaviors 

panel to open the interface.  

3. Select the panel that you wish to act on.  

4. Select the action (Open, Close or Trigger).  

5. Click OK to apply the revised behavior.  
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THE INTERFACE 

The Accordion Panel 2 Magic -Panel Trigger interface allows you to select the which panel to 

trigger. 

 

THE INTERFACE ITEMS 

ACCORDION PANEL TRIGGER 

The interface contains a listing of all of the Heading Links in all of the Accordion Panel 2 

widgets on the page. Select the Heading Link you want to trigger. 

The Heading Links are listed by their ID, which follow a unique naming convention, 

beginning with "p7APMt" followed by the Accordion Panel 2 widget number, an underscore, 

and then the content panel number. For example, "p7APMt1_1" would be the first Heading 

Link in the first Accordion Panel 2 widget on the page, while "p7APMt3_2" would be the 

second Heading Link in the third Accordion Panel 2 widget on the page. 

ACTION 

Select the action you want to apply.  

Note: Any toggle options set for this widget will also apply. 

OPEN 

This will open the selected panel. If the panel is already open then it will remain open.  

CLOSE 

This will close the selected panel. If the panel is already closed then it will remain closed.  
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TRIGGER 

This will emulate a user mouse click on the Panel Heading in one of two ways:  

1. If the Panel Heading has an associated content panel then that panel will become 

active. 

2. If the Panel Heading does not have an associated content panel ( Link Only option), 

then the hyperlink assigned to the Panel heading will be activated. 

 

THE INTERFACE CONTROL BUTTONS 

OK 

When you have made your selection, click the OK button to apply the behavior. By default the 

behavior will be applied to the "onClick" event of the text link or image. You can change the 

event by selecting the desired event in the Behaviors panel.  

CANCEL 

Click the Cancel button to completely abort the current operation. This will close the 

interface and no changes will be made to your page. 

HELP 

Click the Help button to open the associated Help File in your browser. This page can remain 

open for easy reference while you continue working with the Accordion Panel 2 Magic 

interface. 
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PVII ACCORDION PANEL 2 MAGIC -OPEN/CLOSE ALL 

OVERVIEW 

The Open/Close All Behavior allows you to set link anywhere on your page to remotely Open 

or Close All Panels in any Accordion Panel 2 widget on your page. The behavior can be set to 

act on a single Accordion Panel 2 widget or all of the Accordion Panel 2 widgets on your 

page. 

CREATING A NEW OPEN/CLOSE ALL BEHAVIOR 

1. Select (click) a text link or image to act as the behavior trigger.  

2. Click the plus sign (+) on the Behaviors panel.  

3. Choose Studio VII > Accordion Panel Magic 2 >Open/Close All to open the interface.  

4. Select the panel that you wish to act on.  

5. Select the action and other options  

6. Click OK to apply the behavior.  

 

MODIFYING AN EXISTING OPEN/CLOSE ALL PANEL BEHAVIOR 

1. Select the element that contains an existing Accordion Panel 2 Trigger behavior.  

2. Double-click the Accordion Panel Magic 2- Open/Close All behavior in the Behaviors 

panel to open the interface.  

3. Select the panel that you wish to act on.  

4. Select the action and other options.  

5. Click OK to apply the revised behavior.  
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THE INTERFACE 

The Accordion Panel Magic 2 -Open/Close All interface allows you to select the options. 

 

THE INTERFACE ITEMS 

ACCORDION PANEL 

The Accordion Panel list contains the IDs for all of the Accordion Panel 2 widgets on the 

page, as well as an All on This Page option. Select an Accordion Panel 2 widget ID to act on 

a specific widget or choose All on This Page to act on all of the widgets on your page. 

The Accordion Panel 2 widgets are listed by their ID, which follow a unique naming 

convention, beginning with "p7APM_" followed by the Accordion Panel 2 widget number.  

ACTION 

Select the action you wish to apply. If the "Show Only One Panel at a Time" or "Always Keep 

One Panel Open" options are active, the system will override the toggle option set on the 

Accordion Panel 2 widget and open or close all of the panels. 

OPEN 

This will open all of the panels in the selected Accordion Panel 2 widget. 

CLOSE 

This will close all of the panels in the selected Accordion Panel 2 widget. 
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THE INTERFACE CONTROL BUTTONS 

OK 

When you have made your selection, click the OK button to apply the behavior. By default the 

behavior will be applied to the "onClick" event of the text link or image. You can change the 

event by selecting the desired event in the Behaviors panel.  

CANCEL 

Click the Cancel button to completely abort the current operation. This will close the 

interface and no changes will be made to your page. 

HELP 

Click the Help button to open the associated Help File in your browser. This page can remain 

open for easy reference while you continue working with the Accordion Panel 2 Magic 

interface. 
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PVII ACCORDION PANEL 2 MAGIC -ROTATOR 

OVERVIEW 

The Accordion Panel 2 Magic system includes a Rotator Behavior that allows you to display 

each of your widget's panels in slide show fashion. Each panel will be displayed sequentially 

with a timed pause (that you can adjust) between panels. The rotation can be limited to one 

cycle of panels or can be set to loop multiple times. 

This feature can also be set to run automatically when the page first loads, in order to gain 

the user's attention and/or expose all of the content panels briefly, and is controlled as an 

option in the main Accordion Panel 2 interface. 

CREATING A NEW ROTATOR BEHAVIOR 

1. Select (click) a text link or image to act as the behavior trigger.  

2. Open the Behaviors Panel (Shift + F4)  

3. Click the plus sign (+) on the Behaviors panel  

4. Choose Studio VII > Accordion Panel Magic 2 > Rotator to open the interface 

5. Select the panel to act on 

6. Select the action and other options  

7. Click OK to apply the behavior 

 

MODIFYING AN EXISTING ROTATOR BEHAVIOR 

1. Select the element that contains an existing Rotator behavior  

2. Double-click the Accordion Panel Magic 2 - Rotator behavior in the Behaviors panel to 

open the interface  

3. Select the panel to act on  

4. Select the action and other options  

5. Click OK to apply the revised behavior 
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THE INTERFACE 

The Rotator interface allows you to select the Rotation options. 

 

THE INTERFACE ITEMS 

ACCORDION PANEL 

The interface contains a listing of all of the Accordion Panel 2 widgets on the page. The 

widgets are listed by ID, which follow a unique naming convention, beginning with "p7APM_" 

followed by the Accordion Panel 2 widget number.  

Select the widget to act on 

ACTION 

Select the action to apply (any toggle options set for this widget will also apply). 

PAUSE 

This will stop (pause) the Rotator and whichever panel is currently displayed will remain 

displayed.  

PLAY OR RESUME 

This will start a Rotator cycle. Each panel will be displayed successively and rotation will 

continue for the number of cycles specified. 
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NUMBER OF CYCLES 

This controls the number of times the system will repeat each rotation. All panels are 

displayed in one rotation. The system will replay the rotation again for the number of times 

specified in this option. 

START WITH PANEL 

You can select which panel the rotation will start with. 

CURRENT ACTIVE PANEL 

Check this box if you want the rotation to start with the panel that is currently open. This is 

the default and is also the option to use if you are creating a "Resume" behavior. 

PANEL NUMBER 

Enter the number of the panel you want the rotation to start with. You must also uncheck the 

Current Active Panel box to enable this feature. 

THE INTERFACE CONTROL BUTTONS 

OK 

When you have made your selection, click the OK button to apply the behavior. By default the 

behavior will be applied to the "onClick" event of the text link or image. You can change the 

event by selecting the desired event in the Behaviors panel.  

CANCEL 

Click the Cancel button to completely abort the current operation. This will close the 

interface and no changes will be made to your page. 

HELP 

Click the Help button to open the associated Help File in your browser. This page can remain 

open for easy reference while you continue working with the Accordion Panel 2 Magic 

interface. 
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QUESTIONS AND ANSWERS 

The following information should prove helpful as you build and manage your widgets. 

HOW ARE THE ACCORDION PANEL MAGIC 2 CSS FILES AND RULES NAMED? 

The CSS files follow a naming convention based on the Style Theme you have chosen. Here is 

a reference list for you: 

 01-Basic | p7APM01.css 

 02-Carbon | p7APM02.css 

 03-Greystone | p7APM03.css 

 04-Bluestone | p7APM04.css 

 05-Cayenne | p7APM05.css 

 06-Citrus | p7APM06.css 

 07-Teal | p7APM07.css 

 08-Emerald | p7APM08.css 

 09-Image-Based | p7APM09.css 

 10-Onyx | p7APM10.css 

 11-FAQ-In-Blue | p7APM11.css 

 12-Transparently | p7APM12.css 

The selector names inside each CSS file are all prefaced with the class name assigned to the 

root menu DIV. This class name matches the name of the CSS file used. Here is a reference 

list of the class name selectors: 

 01-Basic | p7APM01 

 02-Carbon | p7APM02 

 03-Greystone | p7APM03 

 04-Bluestone | p7APM04 

 05-Cayenne | p7APM05 

 06-Citrus | p7APM06 

 07-Teal | p7APM07 

 08-Emerald | p7APM08 

 09-Image-Based | p7APM09 

 10-Onyx | p7APM10 

 11-FAQ-In-Blue | p7APM11 

 12-Transparently | p7APM12 

As we discuss CSS style editing from this point on, we will refer to style rule names 

(selectors) as beginning with .p7APMxx where xx is the style theme number (01 or 05, for 

example) 
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HOW DO I USE OR MANAGE WIDGETS IN DIFFERENT FOLDERS? 

When you create a widget, the system writes a folder named p7apm and a Fireworks folder in 

the folder that contains the page you are working on - and uses that folder to store style 

sheets, images, and scripts. This allows for easy and safe prototyping. If you create a widget 

on page1.htm, in a folder named tutorials, and edit the CSS for that menu, your changes are 

restricted to that folder. Make another page in that folder and create a widget using the same 

Style Theme and it will use the same style sheet you edited while working on page1. If you 

create a widget on a page in a new folder, the system will create new p7apm and Fireworks 

folders inside that folder and populate it with default style sheets, scripts, and images. This 

allows you to test and prototype with complete freedom - without affecting finalized pages 

in other folders. 

There may, however, be times when you want widgets in different folders to use the same 

style sheets. To do that, create your widgets first. Then decide which p7apm assets folder 

you want to use for all your pages. You'll need to set the paths for all Accordion Panel 

Magic 2 CSS files, and the JavaScript file, to point to the p7apm assets folder you want to 

use. For a page with both a Cayenne menu, the CSS and script links look like this: 

<script type="text/javascript" src="p7apm/p7APMscripts.js"></script> 

<link href="p7apm/p7APM03.css" rel="stylesheet" type="text/css" media="all" /> 

You can change the path to CSS or script files visually in Dreamweaver by displaying Head 

Content in a toolbar at the top of your design window. To turn this feature on, choose View 

> Head Content. 

 

Click the appropriate icon and your Property Inspector will change to reflect your choice, 

easily enabling you to browse to the location of the assets folder you want to use. 
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CAN I REVERT BACK TO A DEFAULT STYLE THEME CSS FILE? 

Should you ever make a large error and need to revert back to a default and working CSS file, 

do this:  

1. Delete the bad CSS file from your p7apm folder 

2. Open a page in that folder that contains a widget that uses that bad style sheet. Your 

widget will appear unstyled. Don't worry, that's expected, given the circumstances 

3. Place your cursor inside the widget 

4. Open the Accordion Panel Magic 2 UI in Modify Mode 

5. Make no changes in the UI - simply click the OK button 

6. The system will create a new version of the appropriate CSS file 

Depending on your DW version, you might not see the changes at first. If that be the case, 

save and close the file, then re-open it. 

HOW DO I SET FONT (TYPEFACE) STYLES FOR MY WIDGET? 

If you'd like to edit the font styles for your widget, open Dreamweaver's CSS Styles panel and 

locate the .p7APMxx rule in your widget style sheet(s) (where xx corresponds to the Style 

Theme of your widget). You'll find the following 2 declarations in the rule: 

font-family: Arial, Helvetica, sans-serif; 

font-size: 12px; 

Change them to suit your needs. 

Tip: font-size: inherit simply means that the widget font-size will be inherited from the parent elements on your page. If you place 
the widget inside a container that has a font-size set, the widget will inherit that value. 

CAN I SET DIFFERENT FONT STYLES FOR MY PANEL HEADINGS? 

Yes. You would edit this rule: 

.p7APMxx .p7APMtrig h3, .p7APM01 .p7APMtrig h4 
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CAN I USE ACCORDION PANEL MAGIC 2 ON THE SAME WITH OTHER PVII 

WIDGETS? 

Yes. You can use APM 2 and any other PVII Widget on the same page. 

CAN I INSERT AN ACCORDION INSIDE A GLIDE PANEL, ELEVATOR OR TAB 

PANEL WIDGET? 

Yes. You can insert one or more Accordion widgets inside the content panels of a Glide Panel 

Magic , Elevator Panel Magic, or Tab Panel Magic widget. And you can also insert Glide 

Panels, Elevator Panels, or Tab Panels inside an Accordion widget. 

CAN I INSERT A PVII GALLERY WIDGET INSIDE AN ACCORDION? 

Yes. Lightshow Magic, Image Gallery Magic, and Slide Show Magic will work inside an 

Accordion widget. The only things to note are: 

 Image Gallery DHTML animations will not function 

 If Slide Show Magic is running in auto-play mode, it will continue to play even if you 

hide its panel 

  

http://www.projectseven.com/products/tools/index.htm
http://www.projectseven.com/products/tools/glidepanel/index.htm
http://www.projectseven.com/products/tools/glidepanel/index.htm
http://www.projectseven.com/products/tools/elevators/index.htm
http://www.projectseven.com/products/tools/tabpanel/demo/index.htm
http://www.projectseven.com/products/galleries/lightshow/index.htm
http://www.projectseven.com/products/galleries/hgmagic/index.htm
http://www.projectseven.com/products/galleries/ssm/index.htm
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CAN I EDIT THE BACKGROUND IMAGES? 

Yes. When you create a widget, the system will also create a Fireworks folder containing the 

editable background images for your widget. Fireworks is the default web image editor for all 

Adobe® Creative Suite products. 

Tip: We suggest that you do not change the size of these images unless you really know what you are doing.  

There are 3 Fireworks files: 

1. p7APM2_main.png 

This file is always present in the Fireworks folder and contains all icons, as well as 

background images for every theme except for Onyx and Transparently.  

2. p7apm_trans.png 

This file is always present in the Fireworks folder and contains the transparent 

content background for the Transparently theme.  

3. p7apm_onyx.png 

This file is only present in the Fireworks folder if you're using the Onyx theme and it 

contains the Panel Heading background images specific to the Onyx theme. 

Once you complete your edits, export your images back to the relevant p7apm/img folder to 

overwrite the originals. Use these export settings: 

 

Note: The File name box is irrelevant since you are exporting slices. 

http://www.adobe.com/products/fireworks/
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HOW DO I CHANGE THE DEFAULT, HOVER, OR DOWN STYLES FOR MY PANEL 

HEADINGS? 

Locate the following rules in your relevant TMM2 style sheet... 

This rule styles the default link state: 

.p7APMxx .p7APMtrig a 

This rule styles the hover state: 

.p7APMxx .p7APMtrig a:hover 

Your style sheet will also contain link and hover rules for Panel Headings that are set to Links 

Only: 

.p7APMxx .p7APMtrig .p7APM_ext, .p7APM01 .p7APMtrig .p7APM_ext.p7APMtrig_down 

.p7APMxx .p7APMtrig .p7APM_ext:hover 

This rule styles the down state (when a heading's panel is showing): 

.p7APMxx .p7APMtrig .p7APMtrig_down, .p7APM01 .p7APMtrig .p7APMtrig_down:hover  

You can, if you want, style a hover state for the down state by using this rule: 

.p7APMxx .p7APMtrig .p7APMtrig_down:hover 

Change properties and values to suit. 

HOW DO I SET THE WIDTH OF MY WIDGET? 

APM2 widgets are designed to automatically conform to the width of the container in which 

they are placed, even if that container is a flexible width. If, however, there is a need to 

constrain the menu to a specific width, use the .p7APMxx rule (it will be the first rule in your 

widget style sheet): 

.p7APMxx { 

width: 200px; 

}  
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WHY IS MY STYLE SHEET FULL OF !IMPORTANT NOTATIONS? 

This is done to prevent style conflicts with your existing page styles. Color and background-

color values should retain the !important notation—do not remove them unless your CSS 

skills are advanced. 

HOW DO I CHANGE THE APPEARANCE OF THE CURRENT MARKED LINK THAT 

HIGHLIGHTS THE PAGE YOU ARE ON? 

Locate the following rule in your relevant Accordion Panel Magic 2 style sheet: 

This rule styles the top-level Current Marked link state: 

.p7APMxx .current_mark 

This rule styles the Current Marked link state for links inside the content panels:  

.p7APMxx .p7APMpanelcontent .current_mark 

Change properties and values to suit. 

MY IMAGE SWAPS ARE NOT WORKING OR ARE SHOWING BROKEN IMAGES. 

WHAT'S WRONG? 

Make sure you are using the correct image naming convention and all required images are in 

the same folder—and that you have set the appropriate Image Swap Options in the Accordion 

Panel Magic 2 interface. 

IS THERE A PLACE ON THE PVII SITE WHERE I CAN FIND MORE EXAMPLES OR 

TWEAKS? 

Yes. Go to the APM2 User Guide Home Page. All new content will be linked from there. 

  

http://www.projectseven.com/products/tools/accordion2/userguide/index.htm
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SUPPORT AND CONTACT INFO 

PVII quality does not end with your purchase - it continues with the best customer support in 

the business. 

PVII KNOWLEDGE BASE  

The PVII Knowledge Base is an online PVII application allowing you to access dozens of Tech 

Notes, tips, and techniques relating to our products, as well as to general web development 

issues.. 

Open the Knowledge Base | View the 10 Most Recent Additions 

NEWSGROUP FORUM COMMUNITIES 

The Project VII Newsgroup community is our primary support vehicle and is available 24 

hours a day. Choose from the following newsgroups:  

1. The PVII Webdev Newsgroup 

2. The PVII Dreamweaver Newsgroup 

3. The PVII Fireworks Newsgroup 

4. The PVII CSS Newsgroup 

Note: If you have trouble linking directly to news servers, use your default newsreader's program options to set up a new 

account and point it at the following server: 

forums.projectseven.com 

Setting up a new newsgroup account in Outlook Express 

Setting up a new newsgroup account in Mozilla Thunderbird  

Setting up a new newsgroup account in Entourage  

If you have another newsgroup-capable program that you are using, please see its 

documentation to learn how to add a new newsgroup account. 

Note: PVII newsgroups are private and have nothing to do with usenet feeds that may be provided by your ISP. That is, you will 
not find our newsgroups in a list of newsgroups distributed by your internet service provider. You must set up our news server as 
a new account.  

  

http://www.projectseven.com/support/questions.asp?type=cat1&id=440
http://www.projectseven.com/support/questions.asp?type=recent
news://forums.projectseven.com/pviiwebdev
news://forums.projectseven.com/dreamweaver
news://forums.projectseven.com/fireworks
news://forums.projectseven.com/css
http://www.projectseven.com/support/oe.htm
http://www.projectseven.com/support/tbird.htm
http://www.projectseven.com/support/entourage.htm
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RSS NEWS FEEDS 

Keep up with the latest news the minute it's released by subscribing to our RSS news feed. If 

you are not sure how to subscribe, please check this page: 

PVII RSS Info 

BEFORE YOU CONTACT US 

Before making a support inquiry, please be certain to have read the documentation that came 

with your product. Please include your Dreamweaver version, as well as your computer 

operating system type in all support correspondence. 

E-Mail: 

support@projectseven.com 

Phones: 

330-650-3675 

336-374-4611 

Phone hours are 9:00am - 5:00pm Eastern Time U.S. 

SNAIL MAIL 

Project Seven Development 

339 Cristi Lane  

Dobson, NC 27017 

  

http://www.projectseven.com/xml/index.htm
mailto:support@projectseven.com
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